RELEASE NOTES

ContractMaster

SOFTWARE

This document contains summary information on new features, late-breaking product
information, updates, and troubleshooting tips not covered in the Trimble®
ContractMaster documentation.

Introduction

These release notes describe the features and enhancements that are new in version
3000.0.6.81 of the ContractMaster, for the following components only:
ContractMaster

Enterprise Estimating

Enterprise Procurement

Enterprise Contract Management

Enterprise QuoteMaster

Enterprise ToolsMaster

For further support information, go to http://mep.trimble.co.uk/support.

New features and changes

The improvements that have been made to the ContractMaster software are
summarised in the following table.

Upgrade procedure

Updates will be made available through Customer Services.

Version: 3000.0.6
Year: 2017
Month: December
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http://mep.trimble.co.uk/support

Summary of features and changes

NEW FEATURES

ID

Description

MEPCM-81 Alter the title of the requisition email to make it easier to Requisitions
trace

MEPCM-104 Add validation to the Material, Labour and Subcontract Variations
fields

MEPCM-587 Option to be able to create revisions of existing variations Variations

MEPCM-1120 | Add a feature to remove any commodity codes, product Central
ranges, manufacturers, etc. that are no longer active Maintenance

MEPCM-1151 | Net Price deletion routine Central

Maintenance
MEPCM-1295 | Added a new ‘Category Maintenance’ permission ToolsMaster
MEPCM-1303 | Prelim description increased to 50 characters Central

Maintenance /
Tender

BUG FIXES
ID Description
MEPCM-318 Procurement quantities are now correctly updated if Procurement
amended in a posted Daywork
MEPCM-601 Resolved an issue that could result in a discounted price Procurement
being added to a Purchase Order when a net price is
defined against the product
MEPCM-1147 | The 'Size’is now correctly displayed on the byproduct Takeoff
confirmation screen
MEPCM-1139 | The Special screen Incremental search now works correctly | Takeoff
MEPCM-1272 | When creating a View in the Product Library the UOM field | Central
is correctly named Maintenance
MEPCM-1274 | Resolved an issue that could result in a company name not | Enquiries
displaying correctly when added as a contact to an Enquiry
MEPCM-1276 | When adding a Special the Material value is now correctly | Variations

displayed in the grid
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MEPCM-1292 | The tool Issue Date / Time are now displayed correctly ToolsMaster

MEPCM-1293 | Cost Heads can now be correctly assigned to a tool ToolsMaster

MEPCM-1297 | Resolved a refresh issue on the Tools grid ToolsMaster

MEPCM-1300 | Selecting the ‘Only show staff with tools’' option no longer ToolsMaster
causes an error

MEPCM-1311 | Resolved an issue where Prelim Headers were not correctly | Tender
displayed on the Tender Reports
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New feature details

MEPCM-81 - Requisition Email Title

The confirmation email (if set up in Options -> Environment) now includes the Contract
ID and Description so that they can be more easily identified.

[ LI T Notification of Requisition [04] for Contract MP0O04 : Replace boiler @ Silver trees - Message (HTML)

File Message Add-ins ) Tell me what you want to do...

05:27

Notification of Requisition [04] for Contract MP004 : Replace boiler @ Silver trees w

| »

The requisition 04 for Contract MP004 has been firmed by PHIL.
The requisition contains the following item(s):

Normal item... Isolation Valve, 1in
PID : TN6QR
Cat. No. : GHS/0266M
Quantity : 2
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New feature details

MEPCM-104 - Material / Labour / Subcontractor Validation in

Variations

A new feature has been added to Variation to bring it into line with Estimating Takeoff. This
feature allows the user adding items into a variation to see and set a validation status for
Material, Labour and Subcontract (M/L/S) values.

A new permission has been added to allow users to Validate M/L/S rates in a Variation

@ System Administration

Users
User 1D Jzer Mame
PHIL Phil
Su Swyztem Adrministratar
USER1 First User
Permiszions

Details
Add

Copy

B Y] Waluations
E| [v]  Variations
[¥] “iew Header Details
[¥] Wiew Yariations
[l fu /i

T Bl o-e =
[v] Mo‘tmﬁ Posted Yariations

[l

P

Mat/Lab/5C Validation
- AT ST T
L3
[ Supervizor

R =]
Remove |

% |

LR
Statuz

Reqister
Reset

Help

Within the Variation takeoff Client Schedule items added will automatically show as ‘Valid’
against each of the M/L/S rates. Star Rated items will be set according to their corresponding
status within the Product Library and may then be updated within the Variation takeoff

screen.

,, Descrtian Catalogue
P Nurnber

Steel

| Elbow, 90Deq Mitted SDRTT
Elschofusion, PE100 ProFuse Blus

| Trap, Cable Heavy Duty, Pre-Galvanised SRFLTSPG | 7Smmsam
Steel
| Trap, Cable Heavy Duty, Pre-Galvanised | SRFLTSOPG | 150mmsdm

| Bend, 45Deg Flat, PreGalvanised Steel  SRFB7545PG 76mm
| Bend, 90Deq Flal, Pre-Galvanised Steel | SRFB7SPG | 75mm
T25PR1ZP | 125mm

Size Quantity | Pref
Discount % Compound

100,000 0000 0000 5786

500,000 0000 0000 EEB 36

500,000 0,000 0000 £18426

700,000 0,000 0000 19232

10,000 0.000 0000 000

Extra Disc. Material Material Ext] M |

£6796.00]
£33180.0{

£116556.0f
£134624.00]
£0.0f

Labour
 Hours
0216

0316

0200
0200
0.400

Ext Hows | Labour = Lsbour | Labour Ext|
Rate  Cost
7IB00  E1037  £234 2240
158000 £1037  £38 16400
120000 £1037 207 E12420
140000 £10.37  £207 E1449.0
4000 £1037 415 2415

=l < <« 5§

£0.00

£0.00

£0.00
£0.00
£0.00

|Grade Subcon. |Subcon. Ex.‘ S |MetRate

£0.0f £60.20
£0.00 L
£0.00 %33
£0.00 [ £19439
£0.00 AL

The same ‘traffic light' system that is within Estimating takeoff has been employed to give a

visual indicator.

e Green =AllitemsareVorC
e Amber =Atleast 1 itemisVor C
e Red=NoitemsareVorC
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The Valid options are:

Code | Description Meaning

\Y Valid The item is from the Client Schedule or it is a Star Rated item
value that has been marked as Valid by a database administrator

C Confirmed The value has been marked as correct by the user

U Unconfirmed | The value has not been checked

A status may be changed by either:
individually by clicking into the relevant field within the grid and selecting one of the 3
options from the dropdown
From the ‘Edit’ menu (Shown below). This option will set all 3 statuses for the selected

1.

line

B variation: 00013

File | Edit | View Take-off Favorites Report Tools Help

(4 ] Tag Current @ @
Section| Ly Copy...
ID _ L
= 000 Move... Fre-Galvan
E-000] 2 Delete... L
G- 000 Pre-Galvan
- 000 Tag Al P
00 dlvanized 5
g Un-tag Al -l
B 000 a_uvamsed 5
.. noa ‘L'@ Confirm ltem(s) e Ctrl+¥ 2N
L. 000 L uze Blue
Motes
Prompt to Update Neighbouring BOC [tems

T

The status fields have been made available to the filters option to allow their inclusion in a

filter.

Mew Item Filter =
Manne | Uncanfirmed Items |

Filter Parameters :

Field Namne: | Test | Value | And0r
*  Equalz E u E Or |L|

Labour Flag Equals u Or

Subcontract Flag Equalz 1] Or

Expreszion :

MATFLAG=="L1".0R.LABFLAG=="U"0R.SUBFLAG=="L"

Close
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New feature details
MEPCM-587 - Revise a Variation

You can now revise an existing variation. Creating a revision will create a copy of the original
that can be edited and will supersede the variation it was created from.

To create a revision you will need to select the Variation you want to create the revision for
and then click the Revise button.

Variation Summary

Dretails

E

s

Open

Revise...

=
@
=

Delete.

Copy.

y

FWIII']L 5

Help

1

Options.

When revising a variation you must add a reason, this will give an audit trail for future use.

Revise Variation i
s . I 2 e
Y0 |D ;| 00007 | Diescription : | Penthause suite addiion
Rievised By - |5U | Date: |16/11/2017
Reason
ok Cancel

Once a variation has been revised a revision number will be displayed in the list, only the
latest revision may be posted.

Drag a column header bere to group by that column
[ |ID [+]|Rev. [+]| Description [+]
E 00ooi Eutra Sockets
j E 00002 Reception desk lighting
j E 00003 Concourze lighting
L] E 00004 Concourse ighting #2
j E 00005 Restaurant kitchen prep area
L] E 00008 15th Floar Common Area additions
L] E oooo7 Penthouse suite addition
IF 1 & addition
E 00008 Flinth Lighting
L] E 00009 Sky Cafe
L] E 00009 m Sky Cafe
L] E 00009 02 Sky Cafe
g_ E 00010 Car park. 14 alterations
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New feature details

MEPCM-1120 - Product Support Files Clean-up

As you pricing database ages and weekly updates are applied certain supporting data may
no longer be required. A new routine to clean up data in the Product Support Files has been
added. This will allow you to remove any Supplier, Product Ranges, Commodity Codes and

Product Groups that are no longer used or are no longer required.

NOTE: A backup of the data should always be taken prior to using these option.

To open this routine navigate to: Central Maintenance -> Product Support Files -> Clean-up

Suppliers

B support File Clean-up Utility

Suppliers Praduct Ranges  Commadity Codes  Product Groups

Ensure you have backed-up your database before proceeding to delete any records.

| Suppliers with no Account Mumber

1022
1030
1036
1041
1042
1043
1053
1065
1067
1068
1128
1135
1137
1142
1145
1156
1160
1161
1162
1163
1165
1189
1174
1181
1186

11an

1000000000000000000000000OpR

Categony ILAII] l:

Ackermnann

Adaptaflex

Actionair

ALCT Meters Ltd,

AEI| Cables

ALTENCO

FRiedring

Addvent By Heatstore

Honeywell Security - Elec Market
Advance Tapes Intemational Limited
Aico Ltd

Albion ‘Water Heaters Ltd [wolseley]
Airflows Developments Ltd

Alpen UK Ltd

Albion Valves (LK) Ltd

Alpha Heating Innowvations

Alka

etrel UK Ltd

Alumase - Architectural Rairwater
Ambi-Rad Ltd

Alurinium A Supplies Ltd
Appliversal

Andrews 'wWater Heaters

Anglo Nordic Burmer Products Ltd
Ansel Lighting

Lid

[Name Key ~

ACKERMANN
ADAPTAFLEX
ACTIONAIR

ACT METERS LTD
AEICABLES
AUTENCO
REDRING
ADDWENT
HONEYWELL SECUR
ADVANCE TAPES |
AICDLTD

ALBION 'WwWaATER HE
AIRFLOW DEVELOP
ALPEN LK LTD
ALBION VALVES
ALPHA HEATING |
ALTO

METREL UK LTD
ALUMAST
AMBI-RAD L
ALUMINIUM Rw 5U
APPLIVERSAL
ANDREWS WATER H
ANGLO NORDIC BU

ANSELL LIGHTING

MTICCOCRICE 1 TR

Selectal

Select Mone

Delete Selectsd

Tless |

When cleaning up the Supplier list you may select:

e All Suppliers

e Suppliers not linked to products
e Suppliers with no Account Number

These options can be selected in conjunction with a Supplier Category.

To delete suppliers you can either use the Select All button or manually select suppliers by

ticking them and then click the ‘Delete Selected’ button.
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Product Ranges

8 support File Clean-up Utility O be
Ensure you have backed-up your database before proceeding to delete any records.
Suppliers  Product Flanges  Commodity Codes  Product Groups
| ‘ Product Fanges not linked to products V| BEENRE
Al Frodust Ranges | Soleot Nona
| Description | ~
l_ oduct B anges not linked to products
[] ooooz7 OE2684 1933 Filot Devices Compact Range
[ ] ooooso 03539 1347 Conus Red Instal+ Tube (IN25] SRR R
[ 000050 095337 1947 Carus Red Installe Tube (IN24]
[ 000050 095339 1947 Carus Red Install+ Tube (IN32) -
[] ooonsa 096001 1947 Corus Galv Installe Tube (IN33) Lhie
[] ooooso 036002 1947 Corus Galy Install Tube (IN30)
[] ooooso 096004 1947 Corus Galy Install+ Tube (IN31)
[ 000050 096005 1947 Carus Red Install+ Tube (IN28]
] 000050 096006 1947 Carus Red Install+ Tube (IN29)
[] ooooso 096008 1947 Carus Red Install+ Tube (IN2E]
[] ooooso 036009 1947 Corus Galy Install+ Tube (IN26)
[] ooooso 036010 1947 Corus Galy Install+ Tube (IN27)
[ 000050 129526 1947 TaTa BS1387 1/2 Randams - Galw IN28]
[] ooooso 129527 1947 TaTa BS1387 Steel Tube - Galv [IN3E]
[] oooos0 129528 1947 TaTa BS1387 Steel Tube - Galv [IN41]
[] ooooso 1249539 1947 TaTa Red Primer Painted BS 1387 Tube (IM33)
[ 000050 129540 1947 TaTa Aed Primer Painted BS1387 Tube (IN40]
[ oooies 1379 Timers & Thermaostats
[] oooies 086230 1279 Timners
[] oomss 070578 137 Themostats
[] ooo3ts 082348 1053 Themostatic Digital Mizers
[ ooo31a 1053 Space Heating
1 00039 088633 1053 Electric Towel Rails
[ ooomg 023834 1053 Domestic Electric Heating
[] ooo31g 088836 1053 Commercial Electic Heaters
[1_nonata nean 106 5 b

When cleaning up the Product Range list you may select:
e All Product Ranges
e Product Ranges where the supplier doesn't exist
e Product Ranges not linked to Products

To delete Product Ranges you can either use the Select All button or manually select a range
by ticking them and then click the ‘Delete Selected’ button.

Commodity Codes

Support File Clean-up Utility O X
Ensure you have backed-up your database before proceeding to delete any records.
Suppliers  Product Rlanges  Commodity Codes  Product Groups
Select Al
‘ Commodities not linked ta praducts ~
Commodities Select Mone
“
oht D!
] 108 13 Amoured Cable AWA XLPE/LSF
O] 10 a Amoured Cable A KLPE /Lead ERklp st
[ 106 21 Armoured Cable St XLPE ALead
[] 108 23 Bus Cable —
O 10 2 Conlrol Cabls C =
[ 106 27 Control Cable 5
[] 108 28 Control Cable v
[] 109 43 Cable Matting
[ 110 20 Drata Cable American Style
O 115 34 Elbows
O & 33 Shatterproof
] 123 12 Actinic
[] 123 E0 LY Tarwing
[ 124 oo Standalone Lighting Controls
O 12 34 Spotlights - Suspended
[ 129 85 Hiwire Systems
[] 129 30 Intercom Systems
[] 129 40 Stand-Ailone Call Systems
1 139 74 Wireless Call Systems
O 1# 97 Bespoke Control Spstems
O 14 45 Mercury Found/Globe
[ 142 95 Shatter Protected
[ 143 15 Blacklight
[ 142 20 CCFL
[ 143 75 Y Tanning/Curling Lamp
1 tae E CETLE b ki © : ¥
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When cleaning up the Commodity Codes list you may select:
e All Commodities
e Commodities not linked to Products

To delete Commodity Codes you can either use the Select All button or manually select a
range by ticking them and then click the ‘Delete Selected’ button.

Product Groups

& support File Clean-up Utility m] X

Ensure you have backed-up your database before proceeding to delete any records.

Suppliers  Product Ranges  Commodity Codes  Product Groups

Select Al
‘AII Product Groups ~ ‘

All Product Graups

Select Mone

ES10 Cables

E520 Witing Accessories
ER30 Earthing

EE10 Conduit -

EG20 Cable Management ‘E
EE30 Fixings

EE70 Switchgear & Distribution
EGRO0 Cantral Equipment

EE30 Alam & Security

E700 IT & Data Systems

E¥10 Lighting

EB20 Appliances

EB30 Toals

Delete Selected

Mizcellaneous Electrical
MO0 Rainwater 5pstems
mMo20 Soil & Waste Systems
w030 Undergiound Dirainage
M110 Oil Storage & Distribution
M130 Bailers & Flues

w150 Cylinders & T anks
M1E0 “wiater Distribution
w200 Copper Tube & Fittings
mM210 Steel Tube & Fittings
w220 ‘welding Fittings

230 Plastic Pipe & Fittings

rA2An ok e Citi

0 o

When cleaning up the Product Groups list you may select:
e All Product Groups
e Product Groups not linked to Products

To delete Product Groups you can either use the Select All button or manually select a range
by ticking them and then click the ‘Delete Selected’ button.
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New feature details

MEPCM-1151 - Net Price Deletion Routine

Net prices that have been previously defined against database items may now be selectively
deleted should they expire.

To delete net prices navigate to: Central Maintenance -> Product Library and open the

Supplier Details panel by clicking the toolbar button or selecting the Supplier Details option
from the View dropdown menu.

B8 ContractMaster - 830 (44) - SU

File Edit | View { Filter Quotes Options QuickLlinks Reports Tou
@ Home MNavigation aintenance ]
Quick Links
C " o = _
S Toolbar Buttons: Caption & Glyp - D'dEEI T Elsi
o] " ' Suppler: CEFI
£ Price History...
E Delete Historic Prices... hatiohal Limited
Pod  Default View
Lid
Define Views... Crl+W d
Product & = Supplier Details % Ltd [woalseley)
by
@ Luckinslive fiohs
veasurement
Diseol [3]  Discontinued Products otor Control
OO Products with Duplicate IDs...
—
Sunnliers ] = Allo. i

Once you have selected the supplier you can either select ‘All Products’ in the structure tree
or select a specific Manufacturer / Major Range / Minor Range to delete from. Once the

selection has been made you will need to click the ‘Delete Net Price’ button.

Product Maintenance

& AlphaHealing Innovations
(3 Alsten Gitd UK Lid - Measurement
- Alstorn Gird UK Ltd - Motor Contial
- Ahesh
- Altecric Lid
& Ate
£ Waing Accessaries
+ Outdot Earthing Accsssones (ALTS60)
i+ Personal Profection (4LT714)
i+ Taolk & Fiings (ALT719)
Tape (ALT150]
L Other Wit Scsessories (ALT724)
1~ Site Semwices & Industia Phup (ALT709)

-
St [Manuiachuret Rarge Orde | View : Basic [V][] Faers: Mo Fiter Specifed  |v] [ | [
Supplier | CEFONZ ][Oy Elestisel Factors 5]

Mendacturer Range [ Product Delais P [~
(b Advanse Taoes Inematiensl Limted ~ [P0 Cal No. 1 Pioduct Froduct Typ Dther Desc. Maleial/ Colou/Firish Waleiid | Lab

5 | Cost  |Haus

- AE| Cables

3 Aico Lid [T50L0 | AL1225 Rod Earth Copperbond ES4E00 0,250

(& Airflow Developments Lid, T50L3 AL1226 Coupler Earth Flod £45300 0000

(- Albion Vaves [UK Lid T50L2 ALtear Stud Ditving £14000 0,090

- Albion Wiates Hesters Lid [Wolseley) T50L1 A28 Eaith Fi #Cover £330500 0500

& Alpen UK Lid

Delete Net Price

A confirmation screen will then be displayed showing how many products will be affected.

nfirmi

>

@ Delete supplier "CEFOD2" net prices for the 4 items shown?

To proceed select the ‘Yes’ button
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Legal notices

Trimble Inc.

MEP Division

10368 Westmoor Drive
Westminster, Colorado 800021
USA

800-361-1249 (toll free in USA)
+1-937-245-5154 Phone
+1-937-233-9441 Fax
www.trimble.com

Copyright and trademarks
© 2016, Trimble Inc. All rights reserved.

Trimble, and the Globe & Triangle logo are trademarks of Trimble Navigation Limited,
registered in the United States and in other countries.

Microsoft and Windows are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries. All other trademarks are the
property of their respective owners.

Release notice
This is the December 2017 release (Revision A) of the Release Notes. It applies to version

3000.0.6.81 of the ContractMaster software.
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